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Using Addit!
What Does Addit! Do?

Addit! automatically installs user created addons for Microsoft Flight Simulator 5.

Addit! can safely install a wide variety of addon files including aircraft, scenery, textures, situations, 
videos, sounds, panels and panel parts.    And Addit! tucks way other files, such as documents, for safe-
keeping.    Addit! keeps track of everything so removing an addon you don't like is easy and safe.

With Addit!, you'll never have to manually copy files into your Flight Simulator 5 directories again!    That's 
done for you.    Addit! intelligently installs them.    Just point to the addon files (and Addit! can help you find 
them) and click Install.    That's it!

Product Highlights



Using Addit!
Product Highlights

Addit! has many features:

· Automatic identification of addons as you navigate your directories.
· Easy installation of panels and sounds.
· Warns you if installing an addon may conflict with another.
· Fully automatic removal of addons.    A single click does it all!
· Installs addons from any drive in your system or network.
· Enhanced Uninstall Checking prevents removal of files used by other addons.
· Automatic Naming names addons for you.
· View document and image files and play sound files without leaving the program.
· Launch Flight Simulator 5 without leaving the program.
· Restrict Display lets you install only the types of addons you want.
· Warns you about custom installation programs and unpacked archive files.
· Lets you restore some or all of your original Flight Simulator 5 files.
· Online help with graphical examples.



Using Addit!
Quick Tour

This section steps you through a real-world installation example.    You'll learn how to use Addit! to install, 
run and uninstall an aircraft addon.    This example demonstrates Addit! running in a Windows 95 
environment.    For Windows 3.x users, the displays will be a little different.

OK, let's say you found an F/A-18 Hornet aircraft addon somewhere online.    You've downloaded and 
unzipped it to a directory on your hard drive called STUFF.    How do you use Addit! to get those files to 
Flight Simulator 5?    It takes 4 easy steps.

Step 1:    Locate Your Addon Files
Step 2:    Install The Addon
Step 3:    Take It For A Test Flight!
Step 4:    Uninstall The Addon



Using Addit!
Quick Tour
Step 1:    Locate Your Addon Files

First, show Addit! where to find those F/A-18 addon files.    This is done in the Install From section:

Identify the drive holding the addon files in the uppermost box.    Many folks have a single hard drive 
labeled C:.    If that's true for you, the drive is already set.    Next, identify the directory in the middle box.    
Double click to move up and down your directory tree.    Stop when you reach the STUFF directory.    In 
the bottom box you can see the F/A-18 addon files.    Addit! also sees them; at the very bottom of the 
Install From section notice the message MSFS5 addons found.

In this example, the file FA-18.DOC is highlighted.    It's always a good idea to review any documentation 
before installation.    Click the small page icon to read it or just double click the file.

Step 2:    Install The Addon



Using Addit!
Quick Tour
Step 2:    Install The Addon

Now that you've identified the location of your addon files you can install them.

Click Install:

If the Automatic Naming feature is turned off, you'll be asked to name the addon:

Why not name it F-18?    Enter F-18 in the white box and click OK.

Step 2a:    Panel File Installation



Using Addit!
Quick Tour
Step 2a:    Panel File Installation

The F/A-18 addon includes a custom instrument panel so the panel dialogue appears:

Addit! needs to know what Flight Simulator 5 panel file to replace.    Every panel addon comes with 
instructions.    Here, they're included in the F/A-18.DOC file.    These instructions tell you what to replace.   
In this example, a paragraph in F/A-18.DOC says to replace LEAR_S.PNL so choose Learjet S.    Click 
OK.

Step 2b:    Sound File Installation



Using Addit!
Quick Tour
Step 2b:    Sound File Installation

The F/A-18 addon includes a custom sound file so the sound file dialogue appears:

The F/A-18 Hornet is a jet aircraft so replace the jet engine sound.    Select Jet engine and click OK.    If 
you're ever unsure about what to replace click the play sound icon to hear the sound file.    If it sounds 
like a jet engine, replace the jet engine sound, etc.

Step 2c:    Observe The Status Bar



Using Addit!
Quick Tour
Step 2c:    Observe The Status Bar

Addit! tells you what it did in the status bar.    Look at the bottom of the window:

All 4 addon files were installed:    the F/A-18 aircraft, sound, panel and documentation files.

Step 3:    Take It For A Test Flight!



Using Addit!
Quick Tour
Step 3:    Take It For A Test Flight!

Addit! lets you launch Flight Simulator 5 with a single mouse click:

Don't use this feature if you normally run Flight Simulator 5 in DOS or MS-DOS mode.    It's there for 
convenience and works best if you have Windows 95 and prefer to run the game inside Windows.    For 
further information on Windows 95 and Flight Simulator 5 consult these help topics:

Installing Microsoft's Flight Simulator 5.1 Under Windows 95
Running Microsoft's Flight Simulator V5.0A and V5.1 Using Windows 95

When inside Flight Simulator 5, select the F/A-18 from the Aircraft menu.    You'll find yourself in the F/A-
18's cockpit, looking at a new instrument panel with the distinct purr of two General Electric F404 turbofan
engines idling in the background.    Enjoy!

Step 4:    Uninstall The Addon



Using Addit!
Quick Tour
Step 4:    Uninstall The Addon

Let's say the author of the F/A-18 did a wonderful job designing and painting the aircraft but a lousy one 
defining the flight model.    And that makes you mad.    You can no longer stand the addon!    It is time to 
remove those F/A-18 files.

First, select the addon from the list shown in Installed Addons:

Step 4a:    Click Uninstall



Using Addit!
Quick Tour
Step 4a:    Click Uninstall

The Uninstall button becomes active when the addon is selected.    Click it:

Uninstalling deletes the F/A-18 addon files and restores Flight Simulator 5 to its default state.    If you told 
Addit! to confirm all uninstalls, the confirmation dialogue appears.    Click Yes.    Your normal Learjet panel 
and jet engine sound files are restored.

Step 4b:    Observe The Status Bar



Using Addit!
Quick Tour
Step 4b:    Observe The Status Bar

In the status bar, Addit! tells you how many files were removed:



Using Addit!
Explanation of Features

This section provides a more in-depth discussion of most of Addit!'s features.    For features not covered 
here, consult the Quick Tour help topics.

File Menu
Options Menu
Tools Menu

Quick Tour



Using Addit!
Explanation of Features
File Menu

The File menu presents you with 4 choices:    Install Addon, Uninstall Addon, Simulator Info and Exit:

Install Addon works exactly like the Install button:

The Install button and menu option become active when you position to addon files.    Use the Install 
From section to find addon files.    Every file listed will be installed to Flight Simulator 5.

Likewise, Uninstall Addon works just like the Uninstall button:

Both of these choices are available after you select an addon to uninstall.    Uninstalling removes the 
addon files and restores Flight Simulator 5 to its normal condition.

Use Simulator Info to display your Flight Simulator 5 version and location.

Exit shuts down Addit! and saves your settings for next time.



Using Addit!
Explanation of Features
Options Menu

The Options menu lets you customize Addit!:

Restrict Install From Display is useful for installing only certain types of addons like videos.    Right click 
the restrict display icon to quickly remove the current restriction.

Addit! lets you view all document, image and text files listed in the Install From section.    Select the file 
then click the view icon or simply double click the file.    Use Default File Viewer to choose between 
Notepad and Write/WordPad (Write for Windows 3.x users, WordPad for Windows 95 users).

Addit! will name addons for you if Automatically Name Addons is checked.    Turn off this feature if you 
prefer to name addons yourself.

Identical File Handling offers 2 choices.    Choose Always Overwrite to force Addit! to copy over files 
that are the same.    If you choose Ask Before Overwriting, Addit! asks for confirmation before 
overwriting these files.

Enhanced Uninstall Checking also offers 2 choices.    The first, Always Leave Dependent Files 
Installed, forces Addit! to always leave files used by other addons installed.    This option is strongly 
recommended; if you uninstall a file used by another addon that addon may no longer function properly.    
The second choice, Warn Me About Dependent Files, forces Addit! to bring all dependent files to your 
attention.    You may then leave them installed or remove them at your discretion.

If you'd like Addit! to ask for confirmation before uninstalling addon files, check Confirm Uninstalls.

Save Install From Location forces Addit! to save the drive and directory locations when you exit the 
program.    These locations will be used the next time you use Addit!.



Using Addit!
Explanation of Features
Tools Menu

The Tools menu gives you 3 options:    Launch Flight Sim 5, Restore Original MSFS5 Files and Register 
Addit!: 

These options let you start Microsoft Flight Simulator 5 directly from Addit!, restore some or all of your 
original Flight Simulator 5 files and register the program.



Using Addit!
Explanation of Features
Tools Menu:    Launch Flight Sim 5

The Launch Flight Sim 5 menu option works just like the Launch MSFS5 button:

You can launch Flight Simulator 5 in one step using either method.    However, the first time you use this 
feature Addit! may give you a performance tip:

If Flight Simulator 5 runs well without a Shortcut or PIF, check the Don't warn me again box.    Chances 
are it won't and you'll benefit from one.

How To Create A Shortcut For MSFS5



Using Addit!
Explanation of Features
Tools Menu:    Launch Flight Sim 5

How To Create A Windows 95 Shortcut For MSFS5
A Shortcut simply provides a link to a program--a link you can customize.    Normally, when you launch 
Flight Simulator 5, Windows 95 takes its best shot at running it.    With a Shortcut, you help Windows 95 
make an even better shot.

You can create a Flight Simulator 5 Shortcut yourself or use the one in your Addit! directory.    Yes, Addit! 
ships with a Flight Simulator 5 Shortcut!    It's named    "FS.PIF".    Copy it to your Flight Simulator 5 
directory.    If you have Flight Simulator 5.0A or 5.1, that's all there is to it.    If you have Flight Simulator 
5.0, right click on the Shortcut and select Properties.    Click the Program tab.    Where it says, "Cmd line", 
change the entry from FS5.COM to FS5.EXE.    Then you're set!

If you want to create the Shortcut yourself, consult the Windows 95 help topics.    Use the Shortcut found 
in your Addit! directory as an example.

How To Create A Windows 3.x Program Information File (PIF) For MSFS5
The steps are similar to the Windows 95 process described above.    Copy the "FS.PIF" file from your 
Addit! directory to your Flight Simulator 5 directory.    If you have Flight Simulator 5.0A or 5.1, that's all 
there is to it.    If you have Flight Simulator 5.0, run the Windows PIF Editor (it's in your Main group).    Edit 
the "FS.PIF" file and change the "Program Filename" entry from FS5.COM to FS5.EXE.

Please consult your Flight Simulator 5 Pilot's Handbook and README.TXT file and your Windows 3.x 
Users Guide for more information.



Using Addit!
Explanation of Features
Tools Menu:    Restore Original MSFS5 Files

Use this option to copy the files saved during the Addit! setup process back to your Flight Simulator 5 
directories.    It's a good idea to uninstall all addons first.    Addit! will warn you if you haven't.    You can 
restore any combination of aircraft, scenery/textures, situations, panels, sounds and videos.



Using Addit!
Explanation of Features
Tools Menu:    Register Addit!

How Do I Register?



Using Addit!
Disclaimer

Flight Simulator is a trademark of Bruce Artwick.    Microsoft Flight Simulator is copyrighted © 1986-1995 
by the Microsoft Corporation and Bruce Artwick.    They reserve all rights.    They did not write this software
and do not support or endorse it.    The end user of this software and material assumes all risk.    The 
author shall not be held responsible for any damages to hardware or software as a result of using this 
software.    Although every attempt has been made to ensure maximum functionality and compatibility, 
there may be unforeseen circumstances which will cause the program to fail.    Therefore, the user agrees
to accept any and all financial or other loss due to program design, error or misuse.

The author shall not be held liable for damages of any type, financial or otherwise.

If the user is unable to agree to these terms, the software must not be used and should be removed from 
the user's system immediately.

Addit! Copyright © 1996, Joe Stearns.    All rights reserved.



Common Questions And Answers
Get Answers To Frequently Asked Questions

I installed a file but can't find it.    Where did it go?
Don't worry, Addit! put it in the right spot.    If it was a custom Flight Simulator 5 addon file it was placed in 
one of Flight Simulator 5's subdirectories.    Otherwise, it was tucked away in a special directory beneath 
your Addit! program directory.    You can use Windows Explorer or File Manager to find it.

When I uninstalled an addon its said there were errors!
You probably deleted one or more of the addon's files during a previous uninstall.    Addit! can prevent this 
if Enhanced Uninstall Checking is set to Always Leave Dependent Files Installed.

When I use the Launch MSFS5 button, I get a warning.    What should I do?
This feature works best if you're running Windows 95 and have a Shortcut named FS.PIF in your Flight 
Simulator 5 directory.    For details, consult the Launch Flight Sim 5 help topic.

It won't let me use all the features!
You can gain access to all of Addit!'s features by registering:

Why Should I Register?
The Benefits of Registration
How Do I Register?

I know I installed a new panel but when I fly the aircraft it was made for I get my old panel!
Earlier, you probably uninstalled an addon that overwrote the same default panel and that act restored 
your original.    You can only have one panel replacement for a given aircraft active at one time.    Addit! 
warned you about this when you installed the second panel.

I installed a new sound but don't hear it when I fly!
You replaced the wrong Flight Simulator 5 sound.    There's no way Addit! can predict the correct use of 
any sound file so it's up to you.    The sound addon should include documentation that states what file to 
replace.

I installed a new texture a few days ago but now it's gone!
You probably deleted it during an uninstall of a related addon.    Addit! can prevent this if Enhanced 
Uninstall Checking is set to Always Leave Dependent Files Installed.

When I opened a "DOC" file, all I got was a window full of garbage!
Under the Options menu, choose Default File Viewer and select Write/WordPad instead of Notepad.    
Then open the "DOC" file.

The Install, Uninstall and Launch Buttons are grayed out.    Why?
Sounds like Addit! couldn't find Flight Simulator 5.    Pull down the File menu and select Simulator Info.



Registering Addit!
Why Should I Register?

A plea to your legal side...
The shareware concept lets you try before you buy.    You're allowed to use the software for a certain 
amount of time called a "trial period."    The trial period gives you time to decide if the product is right for 
you.    If it is and you decide to keep it, you must register.    After you do, you gain the right to continue 
using the software.

When you install Addit! you agree to pay for it after a 30 day evaluation period.    If Addit! is on your hard 
drive after the 30 days are up, you're in violation of the shareware agreement and you must remove the 
software!

A plea to your heart...
Addit! took a lot of hard work.    The author spent uncounted hours designing, coding, testing and 
packaging Addit! not to mention writing this online help.    Addit! is very useful and has many potent 
capabilities.    Please justify my labor by registering.    You'll get to sleep well each night and I'll get the 
incentive I need to continue producing shareware products.

A plea to your capitalistic side...
The shareware mechanism allows even the smallest developer to provide software to the general public.   
Keep this mechanism alive!    I dread the day when the masses refuse to register software and shareware 
developers simply give up.    That may lead to less creativity and variety and probably dominance by 
larger developers and higher prices overall.    Don't let that happen!

A plea to your greedy side!
There are incentives for registering.    Lead On!



Registering Addit!
The Benefits of Registration

Registration makes all of Addit!'s features and capabilities available.    Registration provides:

Support for more addon files
Sounds
Panels and panel parts including Flight Shop panels
Flight Shop aircraft

Activation of all restricted options
Launch MSFS5
Enhanced Uninstall Checking
Automatic Addon Naming

Improved addon management
Name the addons you install
Replace most all other default Flight Sim 5 files
Warns you if you try to uninstall a file that's used by another addon

What's more, when you register, you're registered for life!    You'll be notified via email of future upgrades 
to Addit!.    When you move to a later version, you'll get a free unlocking number.    Now that's a deal!    
Especially when you consider future versions may cost more.    Now's the time to register!

How Do I Register?



Registering Addit!
How Do I Register?

Registration is $5.95.    To register, fill out the order form and mail it along with your check to the author.    
Remember to include your serial number and email address.    To find your serial number, pull down the 
Addit! Help menu and select About Addit!.

Order Form

When your payment is accepted, you'll be sent an unlocking number.    Use this number to let Addit! know 
you've registered.

How To Tell Addit! You've Registered



Registering Addit!
How Do I Register?
Order Form

Addit! Order Form

Full Name    ___________________________________________________

Address 1    ___________________________________________________

Address 2    ___________________________________________________

City ___________________________ State ______ ZIP _______- ______ 

Phone # (optional):    ___ -    ____ - ________

Your Email Address:    __________________________________________
(Your unlocking number will be sent to this address)

Addit! 1.1:    ________    X    $ 5.95

Amount Enclosed:    $_________

Addit! Serial #:    _______________________________________________
(Your serial # is listed in Addit!'s About screen)

Please make checks payable to:    Joseph Stearns

Mail to:    
Joseph Stearns
1757 Casselberry Road
St. Cloud, MN    56303

PLEASE BE SURE TO INCLUDE YOUR SERIAL #.    YOUR UNLOCKING NUMBER CAN'T BE ISSUED 
WITHOUT IT

Thank you!    I hope you'll enjoy using Addit!



Registering Addit!
How Do I Register?
How To Tell Addit! You've Registered

From the Tools menu, select Register Addit!.    You'll see the registration screen:

Enter your unlocking number in the white box and click OK.    That's it!    Addit! will tell you that you've 
registered and all features will be enabled.



Other Tidbits
Installing Microsoft's Flight Simulator 5.1 Under Windows 95

HOW DO I INSTALL THE GAME?
Click the Start button then select Settings.    Pick Control Panel.    When the Control Panel folder opens, 
double click Add/Remove Programs.    Select "Install...".    Insert the FS5 installation disk and pick Next.    
Windows 95 will look to your floppy drive(s) or CD ROM drive and find the SETUP program.    Select 
Finish.    Choose whatever FS5 setup options you prefer and install the game.    The install program will 
copy files to your hard drive then automatically start FS5.

USING ADD/REMOVE PROGRAM TO INSTALL FS5 DIDN'T WORK.    NOW WHAT?
Try My Computer, Windows Explorer or open a DOS box.    If you bought the floppy version, insert the first
disk into your floppy drive and run the SETUP program.    For the CD version, switch to your CD ROM 
drive and run the SETUP program.    Choose whatever FS5 setup options you prefer and install the game.
The install program will copy files to your hard drive then automatically start FS5.

OH NO, I GOT AN ERROR!
Depending on your computer's configuration, you may get the error, "Unable to lock XMS memory - fatal 
error".    Here, FS5 tried to reserve a portion of XMS memory for storing sound data but Windows 95 
wouldn't allow it.    You have two options, either works:

1)    Select Quit to exit the error screen.    Switch to your FS5 directory, if you're not already there, and 
rerun SETUP, selecting "No sound".    When the graphical portion of SETUP runs, select whatever options
please you then pick Run Flight Simulator.    Bring up the Options menu, select Preferences then Sound.   
Where it says Sound Board, pick yours.    Now make sure XMS Memory is set to "No".    Click OK followed
by Exit Flight Simulator And Restart.

or

2)    Select Quit to exit the error screen.    Open your FS5.INI file and change the "sound_xms" line from 
"sound_xms=1" to "sound_xms=0".    Save the change and restart FS5.

OK, I'VE INSTALLED IT AND IT RUNS BUT THE SOUND CUTS OUT
First, make sure your sound card was setup properly.    If it was, run FS5 and bring up the Options menu.   
Choose Preferences followed by Sound.    Select "Sound Blaster Universal" from the Sound Board drop 
down menu.    Click OK then Exit Flight Simulator And Restart.    

If you still have sound trouble, revisit the Options - Sound - Preferences menu and choose "Synthesized" 
for Engine Sounds.



Other Tidbits
Running Microsoft's Flight Simulator V5.0A and V5.1 Using Windows 95

There are 2 ways to run this simulator:    inside or outside Windows 95.    Each has benefits and tradeoffs. 
Here's more detail:

Running FS5 inside Windows 95.    
Advantages:    you have access to Windows 95 applications and can easily switch between them.
Disadvantages:    you may experience slow frame rates and sound problems.    And FS5 won't run in a 
window--you must use full screen mode.

With this approach, use the default MS-DOS Prompt to run FS5.    Alternatively, double click on the 
program file.

Your system should be configured to use expanded memory.    If it isn't or if you're not sure, follow the 
MEMMAKER instructions at the bottom of this text.

Starting FS5 this way works only if FS5 isn't configured to use XMS memory for sound effects.    Under 
simulator Options - Preferences - Sound you must have the "Use XMS memory" option set to "No".    
Otherwise the game may generate an error, "Unable to lock XMS memory - fatal error" and won't run. 

Even though FS5 works in an MS-DOS box, you might not get sound or you might get garbled or 
intermittent sound.    This is especially true when you use the digitized audio setting.    The Universal 
Sound Blaster sound card option probably won't help but feel free to give it a whirl.

Run the SETUP program in your FLTSIM5 folder and choose Install Flight Simulator.    Go through the 
setup process, as you did when you first installed the game.    When asked to choose between digital and 
synthesized sound, pick synthesized.    And make sure the "Use XMS memory" option is set to "No".    You
may now run FS5 in Windows 95.    

NOTE for UNIVBE users:    The UNIVBE VESA video driver (V5.1a) may give you video problems if you 
switch between FS5 and Windows.

Running FS5 outside Windows 95.
Disadvantage:    you don't have access to Windows 95 applications.
Advantage:    fastest frame rates.

Here, exit Windows 95 using "Shutdown and reboot in MS-DOS mode".    Normally, MS-DOS mode is 
used to run DOS programs that won't run in Windows 95.    However, it can be used to boost the 
performance of DOS games that don't run well inside Windows.    This approach temporarily removes 
most of Windows 95 and is nearly identical to good 'ole MS-DOS.    When you use this option, any 
changes made to CONFIG.SYS and AUTOEXEC.BAT apply to the MS-DOS session and to Windows 95 
itself.    Keep that in mind.

FS5 runs 10 to 25% faster in MS-DOS mode.    Use UNIVBE from SciTech for the fastest frame rates, 
especially in SVGA modes.    UNIVBE is available on AOL.

So how do you do it?    Click the Start button followed by Shutdown.    Select "Restart the computer in MS-
DOS mode".    When your PC reboots, try running FS5.    It's likely you won't have enough conventional 
memory.    If you don't use third party memory management software (such as QEMM), consider running 
MEMMAKER (Windows 95 includes a new version).    

Enter MEMMAKER at the DOS prompt.    Select Continue then pick the Custom Setup option.    When 



asked about EMS memory, choose "Yes" because FS5 benefits from EMS.    Under Advanced Options, 
set "Scan the upper memory area aggressively?" to "Yes".    Also set "Use monochrome region (B000-
B7FF) for running programs?" to "Yes".    Next, you'll be asked for your Windows directory.    Enter your 
Windows 95 directory if the default is incorrect.    After MEMMAKER does its thing, Windows 95 will 
restart.    Click Start followed by Shutdown to reboot to your newly optimized configuration.    Then run 
FS5. 



How To Contact The Author
Send Email To
JoeStearn@aol.com

Send Postal Mail To
Joe Stearns
1757 Casselberry Road
St. Cloud, MN    56303



How To Find The Most Recent Version Of Addit!
America Online
Visit the Flight Simulation Resource Center at Keyword FLIGHT.

ftp.iup.edu
Look in "flight-sim.dir".

Check Six BBS 
Dial 714-362-8299.




